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1. Introduction 

1.1 Objectif 

Ce manuel a pour objectif de fournir un support pour l'utilisation du système informatique ePIC 
afin de permettre aux utilisateurs industriels de remplir leurs obligations en vertu du règlement 
(UE) no 649/2012 du Parlement européen et du Conseil du 4 juillet 2012 concernant 
l'exportation et l'importation de produits chimiques dangereux, ci-après nommé règlement PIC. 
Le manuel décrit comment soumettre et suivre des notifications d'exportation (et des tâches 
associées), des demandes de NRI spécial et des rapports au titre de l'article 10. 
 
Ce manuel (Manuel de soumission ePIC) est ci-après nommé MSE. Tous les manuels de 
soumission préparés par l'ECHA sont accessibles sur le site web de l'ECHA. 

1.2 Icônes, abréviations et terminologie 

Diverses icônes et abréviations spécifiques sont utilisées dans ce MSE. Les icônes sont 
affichées dans des zones particulières du texte afin de mettre en avant des informations utiles 
ou importantes. 
 
Les icônes suivantes sont utilisées dans ce manuel: 

 Informations utiles, conseils, assistance 

 Note très importante 

 
Les abréviations suivantes sont utilisées dans ce manuel: 

Code NC Code de nomenclature combinée 

COM Commission européenne – DG environnement 

Code CUS Code de l'inventaire douanier européen des substances chimiques  

AND Autorité nationale désignée 

ECHA Agence européenne des produits chimiques 

Code SH Code du système harmonisé 

EL Entité légale 

NEA Autorité nationale de mise en œuvre  

PIC Consentement préalable en connaissance de cause 

Règlement PIC Règlement (UE) no 649/2012 

NRI Numéro de référence d’identification 

FDS Fiche de données de sécurité 

http://echa.europa.eu/support/dossier-submission-tools/
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2. Principes généraux 

2.1  Qu’est-ce qu'ePIC? 

ePIC est un système informatique développé et maintenu par l'ECHA, ayant pour objectif 
d'assurer que les procédures requises en vertu du règlement PIC soient supportées par un 
système informatique approprié. ePIC consiste en trois interfaces indépendantes, une dédiée 
aux utilisateurs industriels, une dédiée aux autorités (actuellement l'ECHA, les AND et la COM; 
bientôt également les NEA), et une dédiée aux douanes. L'application facilite l'échange 
sécurisé d'informations entre les utilisateurs industriels et les autorités.  

2.2 Interface pour l'industrie 

L'interface pour l'industrie d'ePIC assure la soumission sécurisée de données et l'échange 
sécurisé d'informations avec les autorités. Par le biais de cette interface, les utilisateurs 
industriels peuvent visualiser et mettre à jour leurs données et suivre leurs soumissions. Les 
utilisateurs industriels peuvent se connecter à ePIC et: 

• soumettre des notifications d'exportation,  

• soumettre des demandes de NRI spécial (individuelles et groupées), 

• soumettre leurs rapports sur les exportations et importations réelles qui ont eu lieu 
pendant l'année civile précédente (conformément à l'article 10 du règlement PIC), 

• gérer leurs mélanges et leurs articles, 

• demander une exemption (le cas échéant),  

• visualiser le statut de notifications et de demandes de NRI spécial soumises, 

• compléter des tâches attribuées par les autorités (p. ex. demandes de nouvelle 
soumission), 

• vérifier si une exportation particulière peut avoir lieu ou non, 

• vérifier si un pays importateur (hors de l'UE) a fourni des informations sur l'importation 
de certains produits chimiques ou de certaines catégories de produits chimiques. 

2.3 Interface pour les autorités 

L’interface ePIC pour les autorités supporte le travail quotidien des autorités dans le cadre de 
la procédure de règlementaire. Par le biais de cette interface, les autorités peuvent effectuer 
leurs tâches et les transmettre à l’ECHA/la COM, et également communiquer de manière 
sécurisée avec les utilisateurs industriels. 

2.4 Interface pour les douanes 

L'interface ePIC pour les douanes est dédiée aux agents des douanes, et leur fournit des 
informations sur les détails et le statut de l'exportation (p. ex. contenu, pays destinataire et si 
l'exportation est autorisée ou non à un moment donné).  
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3. Page d'accueil pour l'industrie 

Après s'être connecté à l'application, l'utilisateur atteint la «Page d'accueil» (Figure 1). La page 
d'accueil est le point de départ qui donne accès à toutes les tâches. Elle fournit également un 
aperçu et un accès facile aux NRI en cours/actifs/inactifs et à toute notification éventuellement 
en attente d'une nouvelle soumission.  
 
Figure 1: Page d'accueil d'ePIC pour l'industrie 

 

La page d'accueil peut être divisée en quatre parties principales: 
 

• La section centrale comprend 7 pavés qui indiquent le nombre de notifications 
d'exportation et de demandes de NRI spécial ayant différents statuts. Ces pavés 
servent également de raccourcis pour atteindre les sections en question de l'application. 
Veuillez noter que le septième pavé indiquant le nombre de rapports au titre de l'article 
10 en attente n'est disponible que si l'utilisateur a un projet de rapport dans le 
système. 

• Le flux de nouvelles se trouve au-dessus des pavés. Le flux de nouvelles affiche deux 
types d'annonces: des nouvelles et des alertes. Les alertes sont affichées dans une 
fenêtre rouge, tandis que les nouvelles sont en bleu. Dans la plupart des cas, des 
alertes sont utilisées lorsque les exportateurs doivent effectuer certaines actions, tandis 
que les nouvelles fournissent des informations génériques. 

• Le menu de gauche (également nommé menu principal) sert de navigateur dans 
l'application qui donne accès à la plupart des fonctionnalités d'ePIC. Il contient 
également une barre de « recherche rapide », dans laquelle un NRI ou un identifiant de 
consentement explicite/d'exemption peut être saisi. 

• La barre supérieure contient un lien vers le module «Comptes ECHA». Une fois 
l'utilisateur redirigé vers «Comptes ECHA», il sera possible de changer d'utilisateur 
(pour les utilisateurs qui disposent de comptes dans différentes EL), d'afficher les 
détails de la partie et de les modifier (si l'utilisateur ePIC est également un gestionnaire 
des comptes ECHA). Pour plus de détails sur les comptes ECHA, veuillez consulter le 
manuel d'utilisation disponible sur le site web de l'ECHA. 
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4. Créer et gérer des mélanges/articles 

Afin de notifier une exportation de mélanges ou d'articles, une bibliothèque de vos mélanges 
ou articles doit tout d'abord être créée. Le mélange/article souhaité peut ensuite être 
sélectionné directement à partir du formulaire de notification d'exportation. Les informations 
fournies pendant la création de votre mélange/article seront automatiquement pré-saisies dans 
les champs appropriés du formulaire de notification d'exportation.  
 
Les fonctionnalités associées d'ePIC sont disponibles dans le menu principal, dans la section 
«Chemicals, Mixtures & Articles» (Produits chimiques, mélanges et articles).  

4.1 Mélanges 

4.1.1 Créer un nouveau mélange 
Pour ajouter un nouveau mélange à votre bibliothèque, cliquez sur le lien «Create mixture» 
(Créer un mélange) dans le menu principal (Figure 2).  

Figure 2: Fonctionnalité Créer un nouveau mélange 

 
 
Une nouvelle page est ouverte avec l'en-tête «Mixture» (Mélange) (Figure 3). Le formulaire 
consiste en trois sections, l'onglet «Summary» (Résumé) étant affiché par défaut.  
 
Tous les champs obligatoires sont repérés par un astérisque .  
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Figure 3: Écran Créer un mélange 

 
 
4.1.2 Onglet Résumé  
Le premier onglet contient des champs pour saisir des informations concernant l'identification 
et la classification du mélange. Les champs suivants sont disponibles et les en-têtes repérés 
par un astérisque indiquent les champs obligatoires: 
 

• Nom*: nom du mélange  
• Code NC*: code de nomenclature combinée du mélange  
• Code CUS: identifiant de l'inventaire douanier européen des substances chimiques (s'il 

est disponible) 
• Code SH: code du système harmonisé du mélange (s'il est disponible) 
• Alias: vous avez la possibilité de fournir un nom de remplacement pour votre mélange. 

Si ce champ est laissé vierge, le nom réel du mélange sera publié sur le site web de 
l'ECHA 

• Classification des dangers*: classification des dangers du mélange  

 Il n'est pas acceptable d'indiquer une référence à la FDS jointe pour le champ 
«Classification des dangers» de la procédure «Créer un mélange». Des 
informations détaillées sur la classification du mélange doivent être saisies dans ce 
champ. 

Une fois les champs ci-dessus complétés, passez à l'onglet suivant. 
 
4.1.3 Produits chimiques de l'annexe I  
Dans cet onglet (Figure 4), il vous est demandé de sélectionner le ou les produits chimiques de 
l'annexe I et d'indiquer leur concentration dans le mélange; les deux champs sont obligatoires. 
Cliquez sur «Add» (Ajouter) après avoir rempli le formulaire. 
 
Si votre mélange contient plusieurs produits chimiques de l'annexe I, les étapes 
susmentionnées doivent être répétées pour chaque produit chimique.  
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 Si vous souhaitez créer un mélange contenant un élément de groupe (p. ex. oxyde 
d'arsenic, CAS 1303-28-2), vous devez sélectionner l'entrée du groupe (p. ex. 
composés d'arsenic) dans la liste déroulante et spécifier la substance exacte en 
indiquant le numéro CAS ou le numéro CE. 

 
Figure 4: Onglet Produits chimiques de l'annexe I 

 
 

 
Vous pouvez modifier un produit chimique qui fait partie de la composition en 
cliquant sur l'icône crayon. 

 Vous pouvez supprimer un produit chimique de la composition en cliquant sur 
l'icône «X» (visible uniquement si plusieurs produits chimiques de l'annexe I sont 
listés dans la composition). Un mélange doit toujours contenir au moins un produit 
chimique. Un nouveau produit chimique doit donc être ajouté avant que le produit 
chimique existant puisse être supprimé. 

 
Cliquez sur «Next section» (Section suivante) pour passer à l'onglet «SDS» (FDS). 
 
4.1.4 Onglet SDS (FDS) 
L'onglet SDS (FDS) (Figure 5) vous permet de joindre une ou plusieurs fiches de données de 
sécurité à votre mélange. Les documents joints seront automatiquement inclus dans la ou les 
notifications d'exportation préparées pour ce mélange.  
 

 Si vous ne joignez pas de FDS à votre mélange, vous n'aurez pas la possibilité de 
le faire pendant la création d'une notification d'exportation pour ce mélange.  

Si vous devez ajouter des FDS supplémentaires à votre mélange à un stade 
ultérieur, vous pouvez le faire en utilisant la fonctionnalité «Manage mixture» 
(Gérer le mélange). 
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Figure 5: Onglet SDS (FDS) 

 
 
Choisissez la langue du document dans le menu déroulant et cliquez sur «Browse» (Parcourir). 
Localisez le fichier sur votre ordinateur dans la fenêtre contextuelle. 
 

 Il est fortement recommandé de charger une FDS en anglais, si possible, car ceci 
facilite le traitement de la notification à la fois par votre AND et l'ECHA. 

 
Une fois toutes les fiches de données de sécurité nécessaires jointes, saisissez le code de 
sécurité et cliquez sur «Upload» (Charger). S'il est illisible, demandez un nouveau code en 
cliquant sur le bouton «get new code» (obtenir un nouveau code). Pour joindre la ou les fiches 
de données de sécurité à votre mélange, cliquez sur «Upload» (Charger). 
 

 Le système écrasera tout fichier existant si vous chargez un nouveau fichier dans 
une langue qui était stockée auparavant. 

 
4.1.5 Boutons Save & Close (Enregistrer et fermer), Save (Enregistrer) et 
Cancel (Annuler) 
Une fois toutes les informations requises saisies, n’oubliez pas d’enregistrer votre mélange afin 
de créer un nouveau dossier. 
 

 Enregistre le dossier, confirme que toutes les données obligatoires ont été 
fournies et redirige l'utilisateur vers le mode de visualisation. 

 Enregistre le dossier et confirme que toutes les données obligatoires ont 
été fournies. En cas d'erreurs, les champs incorrects sont surlignés en 
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rouge avec des messages d'erreur. 

 Annule les entrées actuelles sans enregistrer et redirige vers la page 
d'accueil. 

4.1.6 Rechercher des mélanges 
Pour afficher et modifier vos mélanges créés auparavant, cliquez sur le lien «Manage 
mixtures» (Gérer les mélanges) (Figure 6) dans le menu principal.  

Figure 6: Lien Gérer les mélanges 

 
 
Pour lister tous vos mélanges, cochez la case «Mixture» (Mélange) et cliquez sur «Search» 
(Rechercher) (Figure 7). 
 
Figure 7: Écran Rechercher un mélange/article 

 
 
Tous les mélanges créés sont listés dans les résultats de la recherche (Figure 8). 

Figure 8: Résultats de la recherche 
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Vous pouvez également effectuer une recherche en utilisant le nom du mélange ou le ou les 
produits chimiques de l'annexe I qu'il contient. Ceci fournira une liste de résultats plus courte 
et plus précise. Pour effectuer une recherche en utilisant le nom du mélange, saisissez au 
moins les premiers caractères du nom du mélange dans le champ «Name» (Nom) et cliquez 
sur «Search» (Rechercher).  
Pour rechercher un mélange au moyen du produit chimique de l'annexe I qu'il contient, 
choisissez le produit chimique dans la liste déroulante (Figure 9). 
 
Figure 9: Rechercher par nom/produit chimique de l'annexe I 

 

Pour afficher les détails d'un mélange, cliquez sur le nom du mélange, listé dans la colonne 
«Mixture/Article name» (Nom du mélange/de l'article) des résultats de la recherche.  

4.1.7 Modifier un mélange 
Si vous devez mettre à jour les informations relatives à un mélange, choisissez «Manage 
mixtures» (Gérer les mélanges). Le système vous alertera s'il existe une notification dont le 
statut est «projet» ou «nouvelle soumission en attente», relative au mélange que vous êtes 
sur le point de modifier. Toute modification appliquée au mélange avant la soumission de la 
notification d'exportation sera automatiquement reflétée dans le formulaire de la notification.  

Cliquez sur le lien «Manage mixtures» (Figure 6) (Gérer les mélanges) dans le menu principal.  

Recherchez le mélange que vous souhaitez modifier et cliquez sur le nom du mélange 
(Figure 10). (Diverses manières de trouver des mélanges créés auparavant sont décrites dans 
le chapitre 4.1.6.) 
 
Figure 10: Résultat de la recherche - mélanges 

 
 
Lorsque vous ouvrez le mélange que vous souhaitez modifier, il est par défaut en mode de 
lecture seule. Cliquez sur «Edit» (Modifier) pour appliquer les modifications (Figure 11). 
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Figure 11: Modifier un mélange 

 
 
Toutes les données peuvent être modifiées; les chapitres 4.1.2, 4.1.3 et 4.1.4 contiennent des 
conseils pour le remplissage des champs. 

 N'oubliez pas que les modifications ne sont prises en compte que si vous cliquez 
sur «Save & Close» (Enregistrer et fermer) ou «Save» (Enregistrer). 

 Un dossier de mélange ne peut être supprimé que s'il n'a pas été référencé dans 
une notification d'exportation ou une demande de NRI spécial. 

4.2 Articles 

 Des notifications pour des articles ne sont requises qu'en cas de produits 
chimiques listés dans la partie 2 ou la partie 3 de l'annexe I du règlement PIC. 

 
4.2.1 Créer un nouvel article 
Pour ajouter un nouvel article à votre bibliothèque, cliquez sur le lien «Create article» (Créer 
un article) dans le menu principal (Figure 12).  
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Figure 12: Fonctionnalité Créer un nouvel article 

 
 
Une nouvelle page est ouverte avec l'en-tête «Article» (Figure 13). Le formulaire consiste en 
trois sections, l'onglet «Summary» (Résumé) étant affiché par défaut.  
 
Tous les champs obligatoires sont repérés par un astérisque .  
 
Figure 13: Écran Créer un article 

 
 
4.2.2 Onglet Résumé  
Le premier onglet (Figure 13) contient des champs pour saisir des informations concernant 
l'identification et la classification de l'article. Les champs suivants sont disponibles et les 
informations obligatoires sont repérées par un astérisque. 
 

• Nom*: le nom de l'article  
• Code CUS: identifiant de l'inventaire douanier européen des substances chimiques (s'il 

est disponible) 
• Alias: vous avez la possibilité de fournir un nom de remplacement pour votre article. Si 

ce champ est laissé vierge, le nom réel de l'article sera publié sur le site web de l'ECHA 
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• Classification des dangers*: classification des dangers du produit chimique de 
l'annexe I utilisé dans votre article  

 
Une fois les champs ci-dessus complétés, passez à l'onglet suivant. 
 
4.2.3 Produits chimiques de l'annexe I  
Dans cet onglet (Figure 14), il vous est demandé de sélectionner le produit chimique de 
l'annexe I et d'indiquer sa concentration dans l'article. Les deux champs sont obligatoires, et 
une fois les informations requises fournies, cliquez sur «Add» (Ajouter). 
 
Si votre article contient plusieurs produits chimiques de l'annexe I, les étapes ci-dessus 
doivent être répétées pour chaque produit chimique.  
 

 Si vous souhaitez créer un article contenant un élément de groupe (p. ex. oxyde 
d'arsenic, CAS 1303-28-2), vous devez sélectionner une entrée de groupe (p. ex. 
composés d'arsenic) dans la liste déroulante et spécifier la substance exacte en 
indiquant le numéro CAS ou le numéro CE. 

 
Figure 14: Onglet Produits chimiques de l'annexe I 

 
 

 
Vous pouvez modifier la composition en cliquant sur l'icône crayon. 

 Vous pouvez supprimer un produit chimique de la composition en cliquant sur 
l'icône «X» (visible uniquement si plusieurs produits chimiques de l'annexe I sont 
listés dans la composition). Un article doit toujours contenir au moins un produit 
chimique. Un nouveau produit chimique doit donc être ajouté avant que le produit 
chimique existant puisse être supprimé. 

 
Cliquez sur «Next section» (Section suivante) pour passer à l'onglet «SDS» (FDS). 
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4.2.4 Onglet SDS (FDS) 
L'onglet SDS (FDS) (Figure 15) vous permet de joindre une fiche de données de sécurité à 
votre article. Les documents joints seront automatiquement inclus dans la ou les notifications 
d'exportation préparées pour cet article.  
 

 Veuillez noter que si vous ne joignez pas de FDS à votre article, vous n'aurez pas 
la possibilité de le faire pendant la création d'une notification d'exportation pour 
cet article.  

Si vous devez ajouter des FDS supplémentaires à votre article à un stade ultérieur, 
vous pouvez le faire en utilisant la fonctionnalité «Manage article» (Gérer l'article). 

Figure 15: Onglet SDS (FDS) 

 
 
Choisissez la langue du document dans le menu déroulant et cliquez sur «Browse» (Parcourir). 
Localisez le fichier sur votre ordinateur dans la fenêtre contextuelle. 
 

 Il est fortement recommandé de charger une FDS en anglais, si possible, car ceci 
facilite le traitement de la notification d'exportation par votre AND et l'ECHA. 

 



20 Manuel d'utilisation du système ePIC pour l'industrie   

 

Annankatu 18, P.O. Box 400, FI-00121 Helsinki, Finlande | Tél.: +358 9 686180 | Fax: +358 9 68618210 | echa.europa.eu 

Une fois toutes les fiches de données de sécurité nécessaires jointes, saisissez le code de 
sécurité et cliquez sur «Upload» (Charger). S'il est illisible, demandez un nouveau code en 
cliquant sur le bouton «get new code» (obtenir un nouveau code). Pour joindre la ou les fiches 
de données de sécurité à votre article, cliquez sur «Upload» (Charger). 
 

 Le système écrasera tout fichier existant si vous chargez un nouveau fichier dans 
une langue qui était déjà disponible. 

 
4.2.5 Boutons Save & Close (Enregistrer et fermer), Save (Enregistrer) et 
Cancel (Annuler) 
Une fois toutes les informations requises saisies, n’oubliez pas d’enregistrer votre article afin 
de créer un nouveau dossier. 
 

 Enregistre le dossier, confirme que toutes les données obligatoires ont été 
fournies et redirige l'utilisateur vers le mode de visualisation. 

 Enregistre le dossier et confirme que toutes les données obligatoires ont 
été fournies. En cas d'erreurs, les champs incorrects sont surlignés en 
rouge avec des messages d'erreur. 

 Annule les entrées actuelles sans enregistrer et redirige vers la page 
d'accueil. 

4.2.6 Rechercher des articles 
Pour afficher et modifier vos articles créés auparavant, cliquez sur le lien «Manage articles» 
(Gérer les articles) (Figure 16) dans le menu principal.  

Figure 16: Lien Manage articles (Gérer les articles) 
 

 
Pour lister tous vos articles, cochez la case «Article» (Article) et cliquez sur «Search» 
(Rechercher) (Figure 17). 
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Figure 17: Écran Rechercher un mélange/article 

 
 
Tous les articles créés sont listés dans les résultats de la recherche (Figure 18). 

Figure 18: Résultats de la recherche 

 

Vous pouvez également effectuer une recherche en utilisant le nom de l'article ou le ou les 
produits chimiques de l'annexe I qu'il contient. Ceci fournira une liste de résultats plus courte 
et plus précise. Pour effectuer une recherche en utilisant le nom de l'article, saisissez au moins 
les premiers caractères du nom de l'article dans le champ «Name» (Nom) et cliquez sur 
«Search» (Rechercher).  
Pour rechercher un article au moyen du produit chimique de l'annexe I qu'il contient, 
choisissez le produit chimique dans la liste déroulante et cliquez sur «Search» (Rechercher) 
(Figure 19). 
 
Figure 19: Rechercher par nom/produit chimique de l'annexe I 

 
Pour afficher les détails d'un article, cliquez sur le nom de l'article, listé dans la colonne 
«Mixture/Article name» (Nom du mélange/de l'article) des résultats de la recherche.  
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4.2.7 Modifier un article 
Si vous devez mettre à jour des informations concernant le ou les articles créés auparavant, 
sélectionnez «Manage articles» (Gérer les articles). Le système vous alertera s'il existe une 
notification dont le statut est «projet» ou «nouvelle soumission en attente» au regard de 
l'article que vous êtes sur le point de modifier. Toute modification appliquée à l'article avant la 
soumission de la notification d'exportation sera automatiquement reflétée dans le formulaire 
de la notification.  

Pour commencer, cliquez sur le lien «Manage article» (Figure 16) (Gérer l'article) dans le menu 
de gauche.  

Recherchez l'article que vous souhaitez modifier et cliquez sur le nom de l'article (Figure 20). 
(Diverses manières de trouver des articles créés auparavant sont décrites dans le chapitre 
4.1.6.) 
 
Figure 20: Résultat de la recherche – articles 

 
 
Lorsque vous ouvrez l'article que vous souhaitez modifier, il est par défaut en mode de lecture 
seule. Cliquez sur «Edit» (Modifier) pour appliquer les modifications (Figure 21). 
 
Figure 21: Modifier un article 

 
 
Toutes les données peuvent être modifiées; les chapitres 4.2.2, 4.2.3 et 4.2.4 contiennent des 
conseils pour le remplissage des champs.  
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 N'oubliez pas que les modifications ne sont prises en compte que si vous cliquez 
sur «Save & Close» (Enregistrer et fermer) ou «Save» (Enregistrer). 

 Un dossier d'article ne peut être supprimé que s'il n'a pas été référencé dans une 
notification d'exportation ou une demande de NRI spécial. 
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5. Créer une notification d'exportation  

5.1 Notification d'exportation pour un produit chimique 

Pour créer une notification d'exportation pour un produit chimique, cliquez sur le lien 
«Notification for chemical» (Notification pour un produit chimique)  
(Figure 22) dans le menu principal.  
 
Figure 22: Écran Créer une notification d'exportation pour un produit chimique 

 
Une nouvelle page «Export notification for a chemical» (Notification d’exportation pour un 
produit chimique), qui consiste en six onglets, s'affiche. Une zone commune en haut de l'écran 
(Figure 23) est visible pour toutes les sections et fournit les détails du pays importateur. 
Apparaissent également les boutons «Save» (Enregistrer), «Submit» (Soumettre) et «Cancel» 
(Annuler). 
 
La «Section 1» est affichée par défaut lorsque la notification d'exportation est ouverte.  
 

 Les champs obligatoires sont repérés par un astérisque dans l'ensemble du 
formulaire. 

Figure 23: Zone commune  

 
 
Sélectionnez le pays importateur dans la liste déroulante. (Figure 23) 
 
5.1.1 Section 1: Identité du produit chimique sujet à la notification 
d'exportation 
Les champs suivants sont disponibles dans la «Section 1»: 
 
Désignation usuelle: Sélectionnez votre produit chimique dans la liste déroulante qui 
comprend tous les produits chimiques de l'annexe I. Ce champ est obligatoire, sauf si vous 
fournissez un numéro CE ou CAS.  
 

 Si la substance à exporter est incluse dans une entrée de groupe, il est obligatoire 
de spécifier un numéro CAS ou un numéro CE et non l'entrée de groupe générique. 
Par exemple, si vous souhaitez exporter du bromure d'arsenic (inclus dans le 
groupe «composés d'arsenic»), vous ne pouvez pas identifier la substance par 
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«composés d'arsenic», mais devez fournir le numéro CAS (64973-06-4) ou le 
numéro CE (265-296-8). 
 

Une fois le produit chimique identifié, les numéros de code seront pré-saisis par le système 
dans les sections 1.3.1 à 1.3.4 (le cas échéant). La zone commune dans la partie supérieure 
du formulaire affichera des informations concernant la partie de l'annexe I à laquelle la 
substance appartient (Figure 24).  
 
Nom chimique selon une nomenclature reconnue internationalement (p. ex. IUPAC): 
S'il est disponible, fournissez le nom du produit chimique de l'annexe I utilisé. 
 
Numéro CAS et numéro CE: Obligatoire pour les exportations de produits chimiques inclus 
dans une entrée de groupe (p. ex. composés de tributylétain). Si le système reconnaît le 
numéro CAS ou CE, il pré-remplira le champ «Common name» (Désignation usuelle).  
 

 Lorsqu’un numéro CAS ou CE est fourni pour une substance incluse dans une 
entrée de groupe, ne pas sélectionner le groupe générique dans la liste déroulante 
dans la section «Common name» (Désignation usuelle). 

 
Code du système douanier harmonisé: Si le code SH pour le produit chimique exporté est 
disponible dans le système, il sera pré-saisi. Il est toujours de la responsabilité de 
l'exportateur de vérifier que les informations sont à jour et de les modifier si nécessaire. 
 
Code NC: Si un code NC pour le produit chimique exporté est disponible dans le système, il 
sera pré-saisi. Veuillez noter que le code NC peut ne pas toujours être disponible et que l'ECHA 
ne peut pas garantir que celui fourni est le plus récent. Il est toujours de la responsabilité de 
l'exportateur de vérifier ces informations et de les modifier si nécessaire. 
 
Code CUS: Le code CUS est obligatoire pour les substances et les mélanges auxquels un code 
CUS a été attribué. Le code CUS peut ne pas toujours être disponible et l'ECHA ne peut pas 
garantir que celui fourni est le plus récent. Il est toujours de la responsabilité de l'exportateur 
de vérifier ces informations et de les modifier si nécessaire.  
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Figure 24: section 1  

 
 
Autres numéros: Si vous souhaitez utiliser des identifiants supplémentaires, utilisez la 
première colonne pour le système de numérotation et la seconde pour les données. 
 
5.1.2 Section 3: Informations concernant l'exportation  
Date de première exportation prévue*: Saisissez la date d'exportation prévue 
manuellement ou en utilisant le calendrier. La date d'exportation ne peut pas intervenir moins 
de 35 jours avant la date de soumission de la notification.  
 
Case Emergency Situation (Situation d’urgence): À cocher si l'exportation du produit 
chimique concerne une situation d'urgence dans laquelle tout retard pourrait mettre en péril la 
santé publique ou l'environnement. Un champ de justification1 obligatoire devient disponible 
sous la case afin d'obtenir le NRI spécial, qui est requis pour ce type d'exportation. 
 
Quantité annuelle prévue de la substance/du mélange*: Saisissez la quantité annuelle 
prévue du produit chimique à exporter et sélectionnez l'unité (kg/l) dans la liste déroulante. 
Seul un point (.) peut être utilisé en tant que point décimal et trois décimales au plus sont 
autorisées après le point.  
 
Catégorie prévue dans le pays importateur*: Indiquez la catégorie d'utilisation prévue 
dans le pays importateur en cochant la ou les cases appropriées. Fournissez les informations 

                                           
 
1 Une exemption de l'obligation de notifier au moins 35 jours avant la date d'exportation prévue peut être accordée, 
sur demande motivée de l’exportateur ou de la partie importatrice ou de l’autre pays, lorsque l'exportation du produit 
chimique se rapporte à une situation d’urgence dans laquelle tout retard risque de mettre en péril la santé publique ou 
l’environnement dans la partie importatrice ou l’autre pays importateur.  (Article 8, paragraphe 5, du règlement (UE) 
No 649/2012). 
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relatives aux utilisations prévues dans le ou les champs de texte libre.  
 

 Il est recommandé d'être aussi précis que possible dans la description de 
l'utilisation prévue, notamment si un consentement explicite est requis pour 
l'exportation, car ces informations aident l'AND du pays importateur dans sa prise 
de décision. 

 
Nom de l’importateur, adresse, téléphone, fax et e-mail*: Cliquez sur le bouton «+ 
Manage importers» (+ Gérer les importateurs) pour sélectionner la ou les entreprises 
importatrices pour cette notification d'exportation. Le ou les importateurs appropriés peuvent 
être sélectionnés en cochant la case dans la colonne «Actions» (Figure 25). Si la liste 
d'entreprises affichée est vide, une nouvelle entreprise doit être ajoutée. Plus d'informations 
sur l'ajout d'une nouvelle entreprise sont disponibles au chapitre 5.1.2.1. Il est obligatoire 
d'indiquer au moins un importateur. 
 
Figure 25: Sélectionner l'importateur 

 
 

 Le bouton «+ Manage importers» (+ Gérer les importateurs) n'est disponible 
qu'après la sélection d'un pays importateur. 

 Il est possible d'indiquer plus d'un importateur si nécessaire. Dans ce cas, tous les 
importateurs appropriés doivent être ajoutés à la base de données et sélectionnés. 

 Les détails de l'exportateur sont pré-saisis à partir du module ECHA Accounts 
(Comptes ECHA). Vous pouvez modifier le numéro de téléphone, de fax et l'e-mail 
si vous souhaitez indiquer une personne/un contact spécifique dans cette 
notification d'exportation (Figure 26). L'adresse de votre partie ne peut être 
modifiée que centralement (par un utilisateur qui est également le gestionnaire des 
comptes ECHA) en utilisant le lien disponible. 

 
Figure 26: Détails de l'exportateur dans ePIC 

 
 
5.1.2.1 Saisie des coordonnées d'un partenaire commercial dans ePIC 
Les partenaires commerciaux sont stockés dans ePIC dans une base de données spécifique des 
entreprises. Les exportateurs et les importateurs sont stocké(s ensemble et groupés par pays. 

La liste d'entreprises peut être gérée pendant la création d'une nouvelle notification 
d'exportation/d'un NRI spécial ou pendant la révision du rapp(ort annuel au titre de l'article 10. 
Il est possible d'accéder à la base de données de différentes manières: 

• Notifications d'exportations: il est possible d'accéder a(ux exportateurs en utilisant le 
bouton «Manage Importers» (Gérer les importateurs) dans la section 3.4.  
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• Demandes (de NRI spécial: il est possible d'accéder aux exportateurs en utilisant le 
bouton «Manage Importers» (Gérer les importateurs) dans l'onglet «Export 
Information» (Informations sur l'exportation).  

• Rapport au titre de l'article 10: cliquez sur l'icône crayon dans la colonne 
Exporters/(Importers (Exportateurs/Importateurs). 

Une fois que l'utilisateur se trouve dans la section dédiée d'ePIC (Figure 27), le système affiche 
la liste des partenaires commerciaux dans le pays auquel la notification d'exportation/le NRI 
spécial est adres(sé(e). Si la liste est vide ou ne comprend pas le partenaire commercial 
approprié, l'utilisateur peut ajouter un nouveau dossier d'entreprise en utilisant le bouton «+ 
New company» (+ Nouvelle entreprise) (Figure 28). 

Figure 27: Gérer les partenaires commerciaux 

 

Figure 28: Ajouter un nouveau partenaire commercial 

 
Un formulaire contextuel s'affiche, dans lequel les coordonnées du partenaire commercial 
doivent être saisies. Utilisez le bouton «Save» (Enregistrer) pour stocker les détails dans la 
base de données.  
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Figure 29: Saisir un nouveau partenaire commercial 

 
Gérer les coordonnées en cliquant sur l'icône crayon dans la colonne «Actions». Pour 
supprimer des coordonnées, l'utilisateur doit cliquer sur l'icône «X» dans la colonne «Actions». 

5.1.3 Section 4: Informations sur les dangers et/ou les risques du produit 
chimique et les mesures de précaution  
Lorsque vous complétez la section 4, vous disposez de deux options: 
 

• si vous prévoyez de joindre une fiche de données de sécurité à la notification 
d'exportation, le remplissage des champs 4.1 à 4.4 n'est pas obligatoire. Cochez la 
case «I will attach a copy of the safety data sheet that covers the information required 
below in section attachments» (Je joindrai un exemplaire de la fiche de données de 
sécurité qui couvre les informations requises ci-dessous dans la section pièces jointes); 
la section 4.5 est automatiquement remplie avec «Safety Data Sheet» (Fiche de 
données de sécurité), et les sections 4.1 à 4.4 deviennent optionnelles. 

• Si aucune FDS n'est jointe à la notification d'exportation, les sections 4.1 à 4.4 doivent 
être remplies avec les informations de gestion des dangers et des risques appropriées. 
(Les sections 4.1 à 4.4 sont des champs obligatoires et la section 4.5 est optionnelle).  



30 Manuel d'utilisation du système ePIC pour l'industrie   

 

Annankatu 18, P.O. Box 400, FI-00121 Helsinki, Finlande | Tél.: +358 9 686180 | Fax: +358 9 68618210 | echa.europa.eu 

Figure 30: section 4  

 
 
5.1.4 Section 5: Informations sur les propriétés physico-chimiques, 
toxicologiques et écotoxicologiques du produit chimique 
Les exigences de données pour la section 5 dépendent de si une FDS est jointe à votre 
notification d'exportation ou non (comme pour la section 4). Si vous ne joignez pas de FDS, le 
champ 5.1 devient obligatoire. 
 
Si vous avez déclaré dans la section 4 que vous fournirez une FDS, le champ 5.2 est 
obligatoire et pré-rempli avec «Safety Data Sheet» (Fiche de données de sécurité) comme 
valeur par défaut (Figure 31). 
 
Figure 31: Champs obligatoires dans la section 5 
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5.1.5 Section 6: Résumé de la mesure de réglementation finale prise par le 
pays exportateur 
Résumé et raisons de la mesure de réglementation finale et date d’entrée en 
vigueur*: Fournissez un résumé des restrictions de réglementation et leurs raisons. Vous 
pouvez également utiliser les informations contenues dans ePIC, en cliquant sur le bouton 
English (Anglais), French (Français) ou Spanish (Espagnol), selon l'exigence de langue du pays 
importateur (Figure 32). Si ces informations ne sont pas encore disponibles dans ePIC, le 
bouton ne sera pas actif et vous devez demander conseil à votre AND.  
 

 Si les informations de réglementation ne sont disponibles qu'en anglais, elles 
peuvent être utilisées indépendamment de l'exigence de langue du pays 
importateur. 

 
Figure 32: Mesure de réglementation finale 

 
 
Après avoir choisi la langue appropriée pour les informations de réglementation, une fenêtre 
contextuelle affiche le texte légal. Cliquez sur le bouton «Update» (Actualiser) et le texte sera 
copié dans le champ 6.1. 
 
L’action de réglementation finale a été prise pour la catégorie*: Ces cases indiquent si 
la restriction de réglementation dans l'UE a été introduite pour la catégorie d'utilisation en tant 
que produit chimique industriel ou pesticide. Les informations sont pré-saisies sur la base du 
produit chimique sélectionné.  
 
Utilisations interdites/utilisations autorisées: Au moins un des champs de texte libre doit 
être rempli avec les informations appropriées (500 caractères maximum).  
 
Produit/importé/exporté/utilisé: Fournissez une estimation, si possible, des quantités 
annuelles pour le produit chimique sujet à la notification d'exportation.  
 
Référence au document de réglementation: Fournissez une référence à tout document de 
réglementation qui est pertinent pour la notification d'exportation.  
 
5.1.6 Pièces jointes 
Vous pouvez utiliser «Attach new documents» (Joindre de nouveaux documents) pour charger 
la FDS ou d'autres pièces justificatives pertinentes. 
 
Choisissez le type de document dans la première colonne, puis choisissez la langue dans la 
liste déroulante et cliquez sur «Browse» (Parcourir). Vous pouvez rechercher le fichier à partir 
d'une fenêtre contextuelle.  
 
Le système permet de charger jusqu'à trois documents par défaut. Si vous avez besoin de 
davantage de documents, utilisez le bouton «Attach more documents…» (Joindre plus de 
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documents...).  
 
Une fois le ou les documents que vous souhaitez charger sélectionnés, saisissez le code de 
sécurité et cliquez sur «Upload» (Charger). S'il est illisible, demandez un nouveau code en 
cliquant sur le bouton «get new code» (obtenir un nouveau code). Pour joindre le ou les 
documents à votre notification, cliquez sur «Upload» (Charger). 
 

 Il est fortement recommandé de charger une FDS en anglais, si possible, car ceci 
facilite le traitement de la notification par votre AND et l'ECHA. 

 

 Le système écrasera tout fichier existant si vous chargez un nouveau fichier dans 
une langue qui était déjà disponible. 

 
5.1.7 Boutons Save & Close (Enregistrer et fermer), Save (Enregistrer), 
Submit (Soumettre) et Cancel (Annuler) 
Une fois toutes les informations requises fournies, les options suivantes sont disponibles en 
haut de la notification.   
 

 
Enregistre le dossier et confirme que tous les champs obligatoires ont 
été remplis. En cas d'erreurs, les champs incorrects sont surlignés en 
rouge avec des messages d'erreur. 

 
Enregistre le dossier, confirme que tous les champs obligatoires ont été 
remplis et redirige l'utilisateur vers le mode de visualisation. 

 
Enregistre le dossier, confirme tous les champs obligatoires et passe à la 
page de soumission. 

 
Annule les entrées actuelles sans enregistrer et redirige vers la page 
d'accueil. 

5.2 Notifications d'exportation pour des mélanges/des articles 

Afin de créer une notification d'exportation pour un mélange/article, vous devez tout d'abord 
créer votre mélange/article. Voir le chapitre 4, Créer et gérer des mélanges/articles Les 
informations fournies dans votre mélange/article seront reflétées automatiquement dans les 
champs appropriés du formulaire de notification. 
 

 La création d'une notification d'exportation pour un mélange ou un article est très 
semblable à la création d'une notification d'exportation pour un produit chimique. 
Dans ce chapitre, nous mettrons en évidence les différences. 

 
Pour créer une notification, sélectionnez «Notification for mixture» (Notification pour un 
mélange) ou «Notification for article» (Notification pour un article) (Figure 33) dans le menu 
principal. 
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Figure 33: Créer une notification d'exportation pour un mélange 

 
Le formulaire consiste en six onglets et une zone commune en haut, et fournit les détails du 
pays importateur. Apparaissent également les boutons «Save» (Enregistrer), « Submit » 
(Soumettre) et « Cancel » (Annuler). La section 2 est affichée par défaut et les sections 3 à 6 
sont les mêmes que dans la notification d'exportation pour un produit chimique (voir chapitre 
5.1 pour plus de détails). 

 Les champs obligatoires dans le formulaire sont repérés par un astérisque . 

 
Commencez à remplir votre notification en sélectionnant le pays importateur dans la liste 
déroulante dans la zone commune.  
 
5.2.1 Section 2: Identité du mélange/de l'article à exporter 
Sélectionnez votre mélange/article dans la liste déroulante, qui comprend tous les 
mélanges/articles que vous avez ajoutés au système. 
 
Les champs 2.2 à 2.4 et le tableau sur la «Concentration and information of substance(s)» 
(Concentration et informations de la ou des substances) sont pré-remplis par le système une 
fois le mélange/article sélectionné. 
 
5.2.2 Pièces jointes 
Le tableau [«List of documents attached» (Liste de documents joints)] indique tous les 
documents, y compris la FDS, chargés pour votre mélange/article, les versions anglaises (le 
cas échéant) étant présélectionnées par défaut. Vous pouvez sélectionner des versions 
linguistiques supplémentaires de la FDS en cochant la ou les cases dans la colonne «Action». 
 
S'il manque une version linguistique, ou si le fichier existant n'est pas à jour, vous pouvez 
ajouter la FDS (ou écraser la FDS existante) en modifiant le mélange/l'article dans les sections 
«Manage mixtures» (Gérer les mélanges) ou «Manage articles» (Gérer les articles) d'ePIC. 
 

 Toutes les modifications doivent être enregistrées avant de quitter la page. 

 
Lorsque vous retournez au projet de notification d'exportation après la mise à jour de votre 
mélange/article, le système indique automatiquement les dernières données saisies, y compris 
les pièces jointes. 
 
Vous pouvez charger des documents supplémentaires (autres que la FDS) à partir de l'onglet 
«Attachments» (Pièces jointes) en sélectionnant le type de document, la langue et en 
recherchant le fichier à joindre.  
 
Saisissez le code de sécurité ou, si le code est illisible, demandez-en un nouveau et appuyez 
sur le bouton «Upload» (Charger). 
 

 Il est recommandé de joindre une FDS en anglais au mélange/à l'article, si 
possible. 
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6. Soumettre une notification d'exportation 

Cliquez sur le bouton vert «Submit» (Soumettre) dans la zone commune en haut du formulaire 
(Figure 34). 

Figure 34: Soumettre une notification d'exportation 
 

 

6.1 Projet de notification sans erreurs 

Une page de confirmation s'affiche s'il n'y a pas d'erreurs dans le formulaire de la notification 
d'exportation. Elle récapitule toutes les données fournies, y compris les pièces jointes. Le NRI 
correspondant et le numéro de version de la notification sont disponibles en haut de l'écran. 
 
Si vous devez corriger des informations dans votre notification, cliquez sur «Continue editing» 
(Continuer la modification) pour revenir au formulaire de notification d'exportation en mode 
édition. Appuyez sur «Submit» (Soumettre) pour afficher la page de confirmation mise à jour. 
 
Si vous souhaitez envoyer un message à votre AND au sujet de la notification que vous êtes 
sur le point de soumettre, utilisez la fenêtre de messagerie en bas de la page de résumé 
(maximum 500 caractères).  
 
Cliquez sur «Submit notification to DNA» (Soumettre la notification à l'AND) pour soumettre 
votre notification et vous serez redirigé vers la page de confirmation de la soumission 
(Figure 35). 
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Figure 35: Écran de confirmation de la soumission 

 

6.2 Projet de notification incomplet 

En cas d'erreurs dans le formulaire de notification, les sections et les champs incorrects sont 
surlignés en rouge avec des messages d'erreur spécifiques (Figure 36).  

 Les champs dans la notification d'exportation ne sont pas vérifiés 
automatiquement lors du passage à un autre onglet. ePIC revérifie le contenu des 
champs lorsque vous cliquez sur «Save» (Enregistrer), «Save & Close» 
(Enregistrer et fermer) ou «Submit» (Soumettre). Tout champ corrigé affichera par 
conséquent le message d'erreur jusqu'au déclenchement d'une nouvelle validation. 
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Figure 36: Erreurs affichées dans une notification incomplète 

 
Une fois les erreurs corrigées dans le formulaire, appuyez sur «Submit» (Soumettre) pour 
afficher la page de confirmation (Figure 35). 
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7. Soumettre de nouveau une notification d'exportation 

Une notification soumise peut être de nouveau envoyée à l'exportateur pour corrections si 
l'AND ou l'ECHA identifie des informations incorrectes/manquantes ou si la FDS n'est pas 
appropriée. Le statut de la notification sera dans ce cas «Pending resubmission» (Nouvelle 
soumission en attente).  
 
Vous pouvez accéder à ces notifications à partir du menu «Search & View» (Rechercher et 
afficher) ou à partir du pavé «Notifications pending resubmission» (Notifications en attente 
d'une nouvelle soumission) sur la page d'accueil (Figure 37). 

Figure 37: Notifications en attente d'une nouvelle soumission 

 
 

7.1 Accéder aux messages liés à une notification d'exportation 

Lorsqu’une autorité (AND ou ECHA) demande des modifications supplémentaires de la 
notification d’exportation, elle inclut toujours un message qui décrit les défauts de la 
notification. Vous pouvez accéder à ce message à partir de deux emplacements:  
 

• Cliquez sur l'icône message dans la colonne «Action» dans la liste des résultats de la 
recherche (Figure 38), après application du filtre pour les notifications «Pending 
resubmission» (En attente d'une nouvelle soumission). 

Figure 38: Colonne Actions affichant la présence d'un message des autorités 
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• Ouvrez la notification et accédez au message en sélectionnant «Message history» 
(Historique des messages) (Figure 39) dans le menu déroulant «View» (Afficher).  

 
Figure 39: Option Afficher l'historique des messages 

 

7.2 Nouvelle soumission d'une notification 

Après application du filtre pour les notifications «Pending resubmission» (En attente d'une 
nouvelle soumission) dans la section «Search & View» (Rechercher et afficher), cliquez sur le 
NRI pour ouvrir la notification en mode édition. Effectuez les corrections nécessaires et 
soumettez de nouveau la notification tel que décrit au chapitre 5.1, « Notification d'exportation 
pour un produit chimique». 

7.3 Supprimer une notification d'exportation «en attente» de la liste 
des tâches 

Si des modifications importantes doivent être apportées à la notification d'exportation (p. ex. si 
le produit chimique référencé doit être changé), une nouvelle notification est requise. 

La notification d'origine reste par conséquent dans votre liste des tâches jusqu'à ce que vous la 
«masquiez». Pour masquer une notification, ouvrez-la à partir de la page d'accueil à partir du 
pavé «Notifications pending resubmission» (Notifications en attente d'une nouvelle soumission) 
et cliquez sur son NRI. Sélectionnez «Hide notification» (Masquer la notification) dans le menu 
déroulant «Actions» dans le coin supérieur droit (Figure 40). 

Figure 40: Masquer une notification d'exportation en attente 

 

 Il n'est pas possible de «démasquer» une notification d'exportation une fois qu'elle 
a été masquée. 
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8. Copier une notification 

 
Toutes les notifications d'exportation peuvent être copiées (p. ex. si vous devez soumettre de 
nouveau la même notification que la ou les années précédentes), indépendamment de leur 
statut final. 
 
Recherchez la notification d'exportation en sélectionnant l'option «Search & View» (Rechercher 
et afficher) (Figure 41) dans le menu principal. 
 

Figure 41: Rechercher et afficher une notification d'exportation 

 
 
Effectuez votre recherche avec les critères appropriés (p. ex. NRI/produit chimique/pays 
importateur) et cliquez sur le NRI de la notification que vous souhaitez copier (Figure 42). 
 
Figure 42: Afficher une notification  

 
 
La notification s'ouvrira en mode de lecture seule. Sélectionnez «Create duplicate (new)» 
[Créer une copie (nouvelle)] dans le menu déroulant «Actions» disponible dans la section 
supérieure droite de la page (Figure 43). 
 
Figure 43: Menu Actions 
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Un avertissement vous rappelle de vérifier les données contenues dans la notification 
(Figure 44). 
 
Figure 44: Avertissement de copie de notification 

 
 
Pour continuer, vous devez accepter le message en cliquant sur «OK». 
 
Le système crée une nouvelle notification d'exportation à partir des données contenues dans la 
notification d'origine. Les sections 3.1 (Date d'exportation prévue) et 6.2 (Mesure de 
réglementation finale) sont toutefois vides et surlignées en rouge. Ces champs doivent être 
remplis manuellement (voir chapitre 5.1.2 et 5.1.5 pour des conseils). Vous devez également 
vérifier que les détails de l'importateur et la quantité prévue (qui sont copiés depuis la 
notification d'origine) sont encore applicables. Si ce n'est pas le cas, vous pouvez les modifier. 
Une fois les informations requises fournies/modifiées, vous pouvez soumettre la notification en 
cliquant sur le bouton vert «Submit» (Soumettre) dans la section supérieure. 
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9. NRI spécial 

9.1 Créer une demande de NRI spécial 

Si vous souhaitez exporter: 

a) un produit chimique de l'annexe I ou de l'annexe V à des fins de recherche et d'analyse 
en quantités de 10 kg ou moins, par an et par pays importateur;  

b) un produit chimique listé dans l'annexe I partie 3 et si une décision d'importation 
positive a été publiée dans la dernière circulaire PIC; 

c) si le pays importateur a renoncé à son droit de recevoir une notification d'exportation 
pour ce/tous les produit(s) chimique(s) 

un NRI spécial est requis à des fins administratives. 

Une fois approuvé par votre AND, le NRI spécial permettra à l'exportation de passer les 
douanes sans nécessiter une notification d'exportation complète. 

Pour créer une demande de NRI spécial, cliquez sur «Request for chemical/mixture/article» 
(Demande pour produit chimique/mélange/article) (selon vos besoins) dans la section «Special 
RIN Request» (Demande de NRI spécial) du menu principal. 

9.1.1 Information d'exportation 
Les champs obligatoires sont repérés par un astérisque (*). 

Pays importateur*: Sélectionnez le pays importateur dans la liste déroulante. 

Produit chimique à exporter*: Si l'exportation prévue est pour une substance individuelle 
listée dans l'annexe I, sélectionnez le produit chimique en question dans la liste déroulante. Si 
l'exportation est pour une substance qui est incluse dans une entrée de groupe, vous devez 
spécifier le numéro CAS de la substance dans le champ dédié. 

 Si votre demande de NRI spécial concerne un mélange ou un article, la liste 
déroulante contiendra les mélanges/articles que vous avez créés. 

 
N° CAS: Si vous avez sélectionné un produit chimique dans la liste déroulante, ce champ est 
pré-rempli et non modifiable. Si le produit chimique est inclus dans une entrée de groupe, vous 
devez spécifier son numéro CAS dans ce champ. Si le numéro CAS est reconnu par ePIC, les 
champs dans la section «Chemical information» (Informations sur le produit chimique) seront 
automatiquement remplis. Si le système ne reconnaît pas le numéro CAS, vous devez 
contacter le service d'assistance de l'ECHA.  

Code CUS: Indiquez le code CUS pour le produit chimique ou le mélange. Le code CUS est 
obligatoire pour toutes les substances et tous les mélanges auxquels un code CUS a été 
attribué. 

Date d’exportation prévue*: Sélectionnez la date d'exportation prévue dans le calendrier. 

Utilisation prévue*: Sélectionnez la catégorie d'utilisation prévue pour le produit chimique 
dans le pays importateur.  

Détails de l’utilisation prévue: Si possible, fournissez des détails supplémentaires sur 
l'utilisation prévue dans le pays importateur. 
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Quantité prévue (par an)*: Sélectionnez l'unité (kg/l) et saisissez la quantité prévue à 
exporter.  

Nom de l’importateur, adresse, téléphone, fax et e-mail*: Indiquez le nom, l'adresse et 
les coordonnées de l'importateur. Pour saisir les coordonnées de l'importateur, cliquez sur le 
bouton «Add importer» (Ajouter un importateur), ajoutez les informations et enregistrez.  

 Si vous exportez la même substance sous le même NRI spécial pour plusieurs 
importateurs dans le même pays, les étapes précédentes peuvent être répétées si 
vous souhaitez inclure tous les importateurs dans votre demande. 

 

 Les détails de l'exportateur sont pré-saisis à partir du module ECHA Accounts 
(Comptes ECHA). Vous pouvez modifier le numéro de téléphone, de fax et l'e-mail 
si vous souhaitez indiquer une personne/un contact spécifique pour cette demande 
de NRI spécial. L'adresse de votre partie ne peut être modifiée que centralement 
(par un utilisateur qui est également le gestionnaire des comptes ECHA) en 
utilisant le lien disponible. 

 
Une fois tous les champs nécessaires remplis, cliquez sur le bouton «Next section» (Section 
suivante). 

9.1.2 Pièces jointes 
Vous pouvez joindre des pièces justificatives en utilisant cet onglet. Sélectionnez la langue du 
document, puis cliquez sur «Browse» (Parcourir) pour localiser le fichier sur votre ordinateur. 

Saisissez le code de sécurité ou, si le code est illisible, demandez-en un nouveau et appuyez 
sur «Upload» (Charger). 
 
Une fois tous les champs requis remplis et tous les documents appropriés joints, cliquez sur 
«Submit» (Soumettre) pour transmettre la demande à votre AND.  
 
9.1.3 NRI spéciaux pour des exportations autres qu'à des fins de recherche 
ou d'analyse  
Des demandes de NRI spécial sont également utilisées dans les scénarios suivants: 

- Un pays importateur a renoncé à son droit de recevoir des notifications d'exportation, 
soit pour un produit chimique spécifique (exporté sous la forme d'une substance ou 
inclus dans un mélange/article), soit dans l'absolu. Ces informations vous sont fournies 
dans la section «Importing country info» (Informations relatives au pays importateur) 
d'ePIC. 

- Le produit chimique exporté (exporté sous la forme d'une substance ou inclus dans un 
mélange/article) est listé dans la partie 1 et la partie 3 de l'annexe I du règlement PIC 
et le pays importateur est partie à la convention de Rotterdam ET a donné une réponse 
d'importation positive dans la dernière circulaire PIC. 

Si l'exportation est couverte par un des scénarios susmentionnés, vous devrez effectuer une 
déclaration en bas de la page de confirmation lors de la soumission (et après avoir revu toutes 
les informations saisies). 

Pour le scénario «A», l'utilisateur n'aura qu'une option, tandis que pour le scénario «B», 
l'utilisateur devra choisir la déclaration appropriée parmi deux déclarations disponibles 
(Figure 45). 
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Figure 45: Déclaration concernant l'applicabilité de la demande de NRI spécial 

 

 La procédure de déclaration n'est applicable que si l'utilisation prévue est 
«Recherche et analyse», avec des quantités estimées supérieures à 10 kg/l, ou si 
l'utilisation prévue est différente de «Recherche et analyse». 

9.2 Demande de NRI spécial groupée 

Cette extension à la demande de NRI spécial est disponible dans les cas suivants: 

• un groupe (grand nombre) de produits chimiques doit être exporté dans un ou 
plusieurs pays 

• un produit chimique doit être exporté dans plusieurs pays 

Toutes les exportations doivent remplir individuellement les conditions d'une demande de NRI 
spécial. Bien qu'une seule soumission soit effectuée, ePIC divisera les demandes et générera 
un NRI pour chaque pays importateur. L'AND se réserve le droit de rejeter la demande 
groupée et de vous demander de soumettre plusieurs demandes de NRI spécial à la place. 

 Cette fonction peut être utilisée pour les exportations de produits chimiques de 
l'annexe I ou de produits chimiques de l'annexe V en quantités < 10 kg pour 
recherche et analyse. Veuillez noter que les produits chimiques de l'annexe I et V 
ne peuvent pas être soumis ensemble. Des soumissions distinctes doivent être 
effectuées pour les produits chimiques listés dans chaque annexe. 
 

Pour débuter, cliquez sur le lien «Bulk request» (Demande groupée) dans la section «Special 
RIN Request» (Demande de NRI spécial) du menu principal. 

9.2.1 Informations relatives à l'exportation 
Fournissez des informations sur l'année d'exportation prévue en sélectionnant la valeur 
correcte dans une liste déroulante. 

Sélectionnez le ou les pays vers lesquels vous prévoyez d'exporter et ajoutez-les à la liste 
«Importing countries» (Pays importateurs) en cliquant sur la flèche pointant vers la droite 
entre les deux colonnes. 
 

 Vous pouvez sélectionner plusieurs pays en appuyant sur le bouton «Ctrl» de votre 
clavier tout en sélectionnant les pays. 

 

 Les détails de l'exportateur sont pré-saisis à partir du module ECHA Accounts 
(Comptes ECHA). Vous pouvez modifier le numéro de téléphone, de fax et l'e-mail 
si vous souhaitez indiquer une personne/un contact spécifique dans cette 
notification d'exportation. Les coordonnées de la Partie ne peuvent être modifiées 
que centralement (par un utilisateur qui est également le gestionnaire des comptes 
ECHA) en utilisant le lien disponible. 
 

Une fois tous les champs nécessaires remplis, cliquez sur le bouton «Next section» (Section 
suivante). 
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9.2.2 Pièces jointes 
Chargez deux documents avec votre demande de NRI spécial groupée. Le premier [«Bulk 
Special RIN request» (Demande de NRI spécial groupée)] est le fichier qui contient toutes les 
informations pertinentes concernant votre demande et le second [«Information to Customs» 
(Informations pour les douanes)] doit être un sous-ensemble d'informations issues du premier 
document, excluant les informations confidentielles.  

Votre AND utilisera le premier document, tandis que le second sera à la disposition des agents 
des douanes pour vérifier votre chargement.  

Si vous le souhaitez, vous pouvez charger d'autres pièces justificatives et les joindre à votre 
demande. 

 Le format du fichier «Bulk Special RIN request» (Demande de NRI spécial groupée) 
à charger est déterminé par votre AND. 

 
Saisissez le code de sécurité ou demandez-en un nouveau s'il est illisible et appuyez sur le 
bouton «Upload» (Charger). 
 
Une fois tous les champs requis remplis et tous les documents nécessaires joints, cliquez sur 
«Submit» (Soumettre) pour transmettre la demande à votre AND. 

9.3 Exemption d'urgence 

Si l'exportation du produit chimique est relative à une situation d'urgence2 dans laquelle tout 
retard pourrait mettre en péril la santé publique ou l'environnement, l'exportateur peut 
demander la levée de certaines obligations (p. ex. soumission au minimum 35 jours avant la 
notification d'exportation et fourniture d'un consentement explicite). 

 La demande d'un NRI spécial pour une exportation d'urgence est très similaire à la 
création d'une notification d'exportation standard. Dans ce chapitre, nous mettrons 
en évidence les différences. Pour toutes les autres étapes, consultez le chapitre 
5.1. 

9.3.1 Section 3 - Informations concernant l'importation 
La case «Emergency Situation [in accordance with Article 8, paragraphe 5,]» [Situation 
d'urgence (conformément à l'article 8(5)] doit être cochée.  Une fois cette case cochée, le 
champ justificatif situé sous celle-ci devient disponible. Il est nécessaire de fournir une 
justification pour la situation d'urgence afin d'obtenir le NRI spécial, qui est requis pour ce type 
d'exportation. 
 
9.3.2 Pièces jointes 
En plus de toute fiche de données de sécurité, un document de type «Emergency Situation» 
(Situation d'urgence) doit être joint. Ce document doit fournir des explications détaillées sur la 
nature de la situation d'urgence. 

                                           
 
2 Une exemption de l'obligation de notifier au moins 35 jours avant la date d'exportation prévue peut être accordée, 
sur demande motivée de l’exportateur ou de la partie importatrice ou de l’autre pays, lorsque l'exportation du produit 
chimique se rapporte à une situation d’urgence dans laquelle tout retard risque de mettre en péril la santé publique ou 
l’environnement de la partie importatrice ou l’autre pays importateur.  [Article 8, paragraphe 5, du règlement (UE) No 
649/2012]. 
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10. Suivre vos notifications 

10.1 Historique des évènements 

En utilisant la fonctionnalité d'historique des évènements, les exportateurs peuvent suivre la 
progression de la notification d'exportation soumise et des tâches associées. Le rapport 
donnera des informations sur les évènements relatifs à la notification, tels que: 

• la soumission, 

• la nouvelle soumission, 

• la vérification de l'AND, 

• la validation de l'ECHA, 

• l'activation de l'ECHA, 

• la demande d'un consentement explicite par l'AND, 

• la demande d'une exemption, 

• le dossier de l'AND d'une réponse à une demande de consentement explicite. 

Pour accéder à l'historique des évènements d'une notification d'exportation, recherchez la 
notification, ouvrez-la et sélectionnez «Event history» (Historique des évènements) dans le 
menu déroulant «View» (Afficher) dans le coin supérieur droit (Figure 46). 

Figure 46: Lien vers «Event history» (Historique des évènements) 

 

10.2 Historique des soumissions 

En utilisant la fonction «Submission history» (Historique des soumissions), l'exportateur peut 
accéder à différentes versions de la même notification d'exportation et les comparer (le cas 
échéant).  

En cas de demande d'informations supplémentaires par l'AND ou l'ECHA après la soumission de 
la notification, l'exportateur peut continuer de travailler sur la notification soumise auparavant. 
Dès que l'exportateur soumet de nouveau la notification, la nouvelle soumission est affichée 
dans «Submission history» (Historique des soumissions), conjointement avec la ou les versions 
préliminaires de la notification d'exportation et toute pièce jointe. 



46 Manuel d'utilisation du système ePIC pour l'industrie   

 

Annankatu 18, P.O. Box 400, FI-00121 Helsinki, Finlande | Tél.: +358 9 686180 | Fax: +358 9 68618210 | echa.europa.eu 

Pour accéder au «Submission history» (Historique des soumissions) d'une notification 
d'exportation, recherchez la notification, ouvrez-la et sélectionnez «Submission history» 
(Historique des soumissions) dans le menu déroulant «View» (Afficher) dans le coin supérieur 
droit (Figure 47). 

Figure 47: Lien vers «Submission history» (Historique des soumissions) 

 

10.3 Alertes e-mail 

L'utilisateur a la possibilité de demander l'envoi d'e-mails à une adresse e-mail prédéfinie 
lorsque des évènements spécifiques se produisent dans le système. Ces évènements incluent, 
sans y être limités: 

• l'AND vérifie une notification d'exportation/demande de NRI spécial 

• l'ECHA valide/active une notification d'exportation 

• une proposition d'exemption est vérifiée 

• un NRI est activé/désactivé à la suite d'une réponse de consentement explicite 

• le statut d'un NRI est modifié 

• la date limite de soumission d'un rapport au titre de l'article 10 approche 

Pour activer les fonctionnalités d'alertes par e-mail, l'utilisateur doit ouvrir la section «Manage 
e-mail notifications» (Gérer les notifications par e-mail) en cliquant sur la flèche à côté du nom 
de l'utilisateur, dans le coin supérieur droit de l'application (Figure 48). 

Figure 48: Paramètres des notifications par e-mail 

 
Si un contact est déjà défini pour l'organisation, l'utilisateur pourra simplement activer les 
notifications par e-mail pour des utilisateurs sélectionnés en cochant les cases «Receive 
notifications» (Recevoir des notifications) dans la colonne «Actions» (Figure 49). 
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Figure 49: Activer les notifications par e-mail 

Si aucun contact n'est disponible dans le système, un contact doit être fourni afin de pouvoir 
activer la fonctionnalité d'alertes par e-mail. Cliquez sur le bouton «Add contact» (Ajouter un 
contact) (Figure 50) et sélectionnez l'icône crayon dans la colonne «Actions». 

Figure 50: Ajouter un nouveau contact 

 

Une fois les coordonnées du nouveau contact fournies, elles peuvent être finalisées en cliquant 
sur l'icône de vérification dans la colonne «Actions» (Figure 51). 

Figure 51: Enregistrer les coordonnées du nouveau contact 
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11. Exemptions 

11.1 Demande d'exemption en l'absence de réponse à une demande de 
consentement explicite (exemption standard) 

Pour l'exportation de produits chimiques/mélanges listés dans la partie 2 ou 3 de l'annexe I, un 
consentement explicite positif de l'AND du pays importateur est nécessaire. 

Si le pays importateur n'a pas répondu sous 60 jours à compter de la date à laquelle l'AND de 
l'UE a demandé un consentement explicite, l'exportateur peut proposer une levée des 
obligations de consentement explicite. Pour cela, l'exportateur doit fournir des documents 
prouvant que la substance est enregistrée ou autorisée dans le pays importateur.  

11.1.1 Proposer une exemption standard 
Pour proposer une exemption, localisez la notification d'exportation en utilisant la 
fonctionnalité «Search & View» (Rechercher et afficher) et ouvrez-la en cliquant sur le NRI 
dans la première colonne de la liste des résultats de la recherche. 

La fonctionnalité «Propose waiver» (Proposer une exemption) se trouve dans le menu 
déroulant «Actions» dans le coin supérieur droit de la page (Figure 52). 

Figure 52: Lien vers «Propose waiver» (Proposer une exemption) 

 

Des documents soutenant la demande d'exemption doivent être chargés dans ePIC. 
Sélectionnez la langue du document, puis cliquez sur «Browse» (Parcourir) pour localiser le ou 
les fichiers sur votre ordinateur. 

 Au moins un document justifiant la proposition d'exemption doit être joint et, s'il 
est dans une autre langue que l'anglais, le français ou l'espagnol, une traduction 
dans l'une de ces langues doit également être fournie.  

 
Saisissez le code de sécurité ou demandez-en un nouveau s'il est illisible et appuyez sur le 
bouton «Upload» (Charger). 
 
Sélectionnez la déclaration légale appropriée et cliquez sur «Submit» (Soumettre). 
 

 Puisque les exemptions standards ne peuvent être demandées que 60 jours après 
la demande de consentement explicite initiale, vérifiez les dates des demandes en 
utilisant la section «Event history» (Historique des évènements). 
 

S'il n'y a aucune erreur dans le formulaire de proposition d'exemption, une page de 
confirmation s'affiche. Vérifiez les informations fournies avant la soumission. 
 
Vous pouvez éventuellement envoyer un message à votre AND (maximum 500 caractères). 
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Cliquez sur «Submit to DNA» (Soumettre à l'AND) pour proposer l'exemption à votre AND. 

11.2 Exemption OCDE 

Si le produit chimique notifié est listé dans la partie 2 de l'annexe I et que le pays importateur 
est membre de l'OCDE, une proposition d'exemption du consentement explicite peut être 
soumise immédiatement après la soumission d'une notification d'exportation et l'obtention d'un 
NRI. L'exportateur doit fournir des documents prouvant que la substance est enregistrée ou 
autorisée dans le pays OCDE importateur.  
 
11.2.1 Proposer une exemption 
Recherchez la notification en question et cliquez sur le NRI pour l'afficher.  
Dans le menu déroulant «Actions», sélectionnez «Propose waiver» (Proposer une exemption) 
(Figure 53).  
 

Figure 53: Option «Proposer une exemption» 

 
 
Un formulaire pré-rempli s'affiche.  
 
Sélectionnez la langue du document et choisissez le fichier à charger. Au moins un document 
justifiant la proposition d'exemption doit être joint. 
 
Saisissez le code de sécurité ou demandez-en un nouveau s'il est illisible et appuyez sur le 
bouton «Upload» (Charger). 
 
Sélectionnez la déclaration légale appropriée et cliquez sur «Submit» (Soumettre). S'il n'y a 
aucune erreur dans le formulaire de proposition d'exemption, une page de confirmation 
s'affiche pour récapituler les informations fournies, y compris les pièces jointes. 
 
Vous pouvez éventuellement envoyer un message à votre AND (maximum 500 caractères). 
 
«Continue editing» (Continuer la modification) vous redirige vers le formulaire de proposition 
d'exemption. 
 
«Submit to DNA» (Soumettre à l'AND) enregistre la proposition et l'envoie à votre AND. Une 
page confirmant la soumission s'affiche et l'identifiant de la demande d'exemption est généré. 
 

 Le formulaire de proposition d'exemption ne peut pas être enregistré 
temporairement; il doit être rempli et soumis en une seule session. 
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12. Rapport au titre de l'article 10 dans ePIC 

ePIC fournit aux utilisateurs industriels un formulaire web qui leur permet de remplir leurs 
obligations au titre de l'article 10 du règlement PIC et de signaler les exportations et les 
importations de produits chimiques soumis au règlement (ainsi que les quantités exactes) qui 
ont eu lieu pendant l'année civile précédente. Dans la mesure du possible, le rapport relatif 
aux exportations est pré-rempli par ePIC lorsque les données sont disponibles dans le 
système. 

12.1  Générer le rapport au titre de l'article 10 

Le rapport est généré automatiquement pour toutes les entreprises qui ont soumis au moins 
une notification d'exportation [y compris les NRI spéciaux autres que ceux relatifs à l'art. 2, 
paragraphe 3)] pendant la période en question. La génération automatique d'un rapport a lieu 
le 1er janvier après la période en question (p. ex. si la période est l'année 2015, le rapport est 
généré le 1er janvier 2016). 

Si l'exportateur n'a pas soumis de notification d'exportation pendant l'année précédente ou si 
l'entreprise n'a effectué que des importations pendant la période en question, le rapport ne 
sera pas généré automatiquement, car le système ne contiendra pas d'informations sur ces 
exportations/importations. Afin de soumettre le rapport au titre de l'article 10, l'utilisateur doit 
le générer manuellement. Le rapport peut être généré en sélectionnant «Create report on 
exports» (Créer un rapport sur les exportations) ou «Create report on imports» (Créer un 
rapport sur les importations) dans la section «Article 10 reports» (Rapports au titre de l'article 
10) du menu principal. 

 Seul un rapport par type de rapport et par année civile peut être généré. Si le 
système a déjà généré un rapport automatiquement, la fonctionnalité de 
génération manuelle est désactivée. 

12.2  Vérifier et compléter le rapport au titre de l'article 10 sur les 
exportations 

Une fois le rapport généré, l'utilisateur peut y accéder à partir de l'option «Search & View» 
(Rechercher et afficher) dans la section «Article 10 reports» (Rapports au titre de l'article 10). 
Le rapport peut être ouvert en cliquant sur l'année du rapport dans la colonne «Year» (Année) 
du tableau affiché. 

Le rapport consiste en trois parties: 

• Le résumé du rapport (Figure 54) où le nom de l'entreprise, le type de rapport et 
l'année du rapport sont affichés. 

Figure 54: Rapport au titre de l'art. 10 - Résumé du rapport 

 
• La deuxième section liste les détails de l'entreprise (Figure 55). Ces informations ne 

peuvent être modifiées que par le biais des paramètres de votre compte ECHA, à 
l'exception du contact. 
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Figure 55: Rapport au titre de l'art. 10 - Détails de l'entreprise 

 

• La troisième partie liste les informations détaillées sur les exportations qui ont eu lieu 
pendant la période en question (Figure 56), telles qu'extraites de la ou des notifications 
d'exportation correspondantes. 

Figure 56: Rapport au titre de l'article 10 - Détails des exportations 

 

12.2.1 Détails des exportations 
Le tableau listant les détails des exportations notifiées contient les informations suivantes: 

• Entrée de l’annexe I: nom de la substance/du groupe listé(e) dans l'annexe I du 
règlement. Ces informations sont pré-saisies pour les exportations notifiées et ne 
peuvent pas être modifiées. 

• Élément de l’annexe I: si l'entrée de l'annexe I concerne un groupe de substances, 
l'utilisateur doit choisir l'élément spécifique qui a été exporté. L'utilisateur doit choisir la 
substance appropriée dans une liste déroulante. Ces informations sont obligatoires et 
doivent être saisies manuellement par l'utilisateur. Si le produit chimique exact a déjà 
été spécifié pendant la création de la notification d'exportation, les informations sont 
automatiquement pré-saisies et ne peuvent pas être modifiées. 
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• Pays importateur: le pays dans lequel la substance/le mélange/l'article a été 
exporté(e). Ces informations sont pré-saisies et ne peuvent pas être modifiées. 

• Quantité: quantité de la substance exportée dans le pays spécifique, en kg. Ces 
informations sont obligatoires et doivent être saisies manuellement par l'utilisateur. 

 Veuillez noter qu'en cas de mélanges et d'articles, la quantité à indiquer est celle 
du produit chimique de l'annexe I contenu dans le mélange/l'article, et non du 
mélange/de l'article dans son ensemble. 

• Art 14, paragraphe 7,: Si la substance exportée est listée dans la partie 2 ou 3 de 
l'annexe I et que l'exportation a été activée sur la base d'une exemption approuvée, 
cette case est pré-cochée et ne peut pas être modifiée. 

• Importateurs: l'utilisateur doit indiquer tous les importateurs dans le pays importateur 
auxquels il a exporté la substance donnée pendant la période en question. Pour ajouter 
le ou les importateurs correspondants, cliquez sur l'icône crayon et sélectionnez le ou 
les importateurs corrects parmi ceux listés, en cochant la ou les cases dans la colonne 
«Actions». Une fois la sélection correcte effectuée, cliquez sur «Update report (back)» 
[Mise à jour du rapport (retour)] pour revenir au rapport au titre de l'article 10. Si 
l'importateur souhaité n'est pas inclus dans la liste, vous pouvez ajouter une nouvelle 
entreprise en suivant les instructions données au chapitre 5.1.2.1.  

• NRI: le ou les numéros de référence d’identification de la ou des notifications 
d'exportation pour la substance spécifiée seront listés dans cette colonne. Ces 
informations sont pré-saisies et ne peuvent pas être modifiées. Si l'exportateur choisit 
de générer un rapport manuellement, il ne sera pas possible d'y ajouter des NRI. 

• Supprimer: seules des exportations saisies manuellement peuvent être supprimées du 
rapport en cochant la case dans cette colonne et en cliquant sur «Save» (Enregistrer). 

12.2.2  Saisie manuelle de données relatives à des exportations 
Si l'exportateur n'a pas soumis de notification d'exportation pendant l'année civile précédente, 
il a la possibilité d'ajouter manuellement des informations sur ces exportations au rapport. 

Cinq exportations maximum peuvent être saisies manuellement, mais cinq rangées 
supplémentaires peuvent toutefois être mises à disposition en cliquant sur le bouton «Save» 
(Enregistrer). 

Tous les champs listés dans le chapitre 12.2.1 sont obligatoires à l'exception du statut de 
l'exemption au titre de l'article 14, paragraphe 7, et du NRI, car ceux-ci ne sont pas 
applicables aux exportations saisies manuellement. 

 Veuillez noter que des informations relatives à l'importateur ne peuvent être 
ajoutées qu'après que toutes les autres informations ont été fournies dans la 
rangée correspondante et que l'utilisateur a enregistré le formulaire. L'icône crayon 
pour modifier les informations relatives à l'importateur devient alors active. 

 Le rapport peut être enregistré à tout moment, de sorte que l'utilisateur peut 
continuer de le modifier ultérieurement.  

12.3 Rapport au titre de l'article 10 sur les importations 

Les rapports au titre de l'article 10 sur les importations ressemblent aux rapports sur les 
exportations: ils présentent le résumé du rapport, les détails de l'entreprise et des 
informations détaillées sur les importations.  
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 Une génération automatique du rapport n'est possible que pour un rapport sur les 
exportations, car les informations sur les importations ne sont pas associées à un 
exportateur et ne sont pas stockées dans ePIC. 

Toutes les informations relatives aux importations doivent être saisies manuellement. Les 
informations relatives aux importations sont requises sous le même format que celles relatives 
aux exportations, avec les exceptions suivantes: 

• Pays exportateur: l'utilisateur doit choisir le pays d'origine de la substance/du 
mélange/de l'article dans la liste déroulante disponible. 

• Exportateurs: l'utilisateur doit fournir des informations sur les exportateurs. Cette 
fonctionnalité fonctionne de manière analogue à celle permettant de fournir des 
informations sur les importateurs. Pour plus de détails, veuillez consulter le chapitre 
12.2.1. 

 Comme pour les entrées manuelles des rapports au titre de l'article 10 sur les 
exportations, les informations relatives à l'exportateur peuvent uniquement être 
saisies une fois que le rapport a été enregistré. L'icône crayon devient alors active 
et des informations peuvent être modifiées/ajoutées. 

12.4 Soumission du rapport au titre de l'article 10 
(exportation/importation) 

Si aucune erreur de validation n'est signalée par le système, une page de confirmation 
s'affiche, sur laquelle l'utilisateur peut vérifier le rapport avant la soumission. Une fois un 
rapport finalisé, l'utilisateur doit cliquer sur «Submit» (Soumettre) pour envoyer le rapport à 
son AND. 

 Si un utilisateur reçoit une erreur de validation lorsqu'il tente de soumettre le 
rapport, le système bloquera la soumission et affichera un message d'erreur pour 
tous les champs pour lesquels un problème a été identifié. 

Si l'utilisateur souhaite revenir au rapport et le modifier, il doit cliquer sur «Continue editing» 
(Continuer la modification). 

12.5 Télécharger un rapport soumis au titre de l'article 10 au format 
Excel 

ePIC permet aux exportateurs et aux importateurs de télécharger leur rapport soumis au titre 
de l'article 10 au format Excel. 

Pour cela, ouvrez le rapport à partir de l'option «Search & View» (Rechercher et afficher) de la 
section «Article 10 reports» (Rapports au titre de l'article 10) dans le menu principal, et ouvrez 
le rapport en sélectionnant l'année en question dans la colonne «Year» (Année). La fonction 
«Download as excel» (Télécharger au format Excel) est disponible dans le coin supérieur droit 
du rapport dans le menu «Actions».  
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Figure 57 Télécharger un rapport au titre de l'article 10 au format Excel 
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13. Fonctionnalités de recherche dans ePIC 

La fonction de recherche permet aux exportateurs de trouver leurs projets de notification, 
leurs notifications soumises et entièrement traitées et leurs demandes de NRI spécial. 

13.1 Rechercher des notifications d'exportation/demandes de NRI 
spécial 

Pour rechercher des notifications d'exportation ou des demandes de NRI spécial, sélectionnez 
l'élément «Search & View» (Rechercher et afficher) dans le menu principal dans la section 
appropriée. Certaines options de filtrage sont prédéfinies selon votre méthode d'accès [p. ex. 
le type de notification «Export notification» (Notification d'exportation) est présélectionné si 
vous avez accédé à la fonction par le biais de la section «Export notifications» (Notifications 
d'exportation]. 

Des champs de texte libre, des listes déroulantes et des cases supplémentaires sont 
disponibles pour affiner vos critères de recherche. 

Les champs suivants peuvent être utilisés pour affiner les recherches: 

• NRI: une notification d'exportation/demande de NRI spécial spécifique  

• Avec messages non lus uniquement: notifications associées à un message non lu 
d'une autorité (AND ou ECHA)  

• Pays importateur: recherche spécifique à un pays 

• N° CAS: recherche spécifique à un numéro CAS  

• Produit chimique: sélectionnez le nom du produit chimique dans la liste déroulante. 

• Mélange: sélectionnez le mélange dans votre liste de mélanges. 

• Article: sélectionnez l'article dans votre liste d'articles. 

• Rechercher: pour indiquer que vous recherchez des demandes de NRI spécial ou des 
notifications d'exportation (ou les deux) 

• Année d’exportation: une plage peut être identifiée en saisissant l'année initiale dans 
le champ «From» (De) et en saisissant l'année finale dans le champ «To» (À).  

• Statut de la notification: six cases pour affiner la recherche à des statuts spécifiques. 
Si aucune des cases n'est cochée, la recherche sera effectuée sur toutes les 
soumissions. 

• Statut NRI: pour effectuer une recherche à partir des critères de statut du NRI (actif 
le/inactif le/désactivé). Pour les options «Active on» (Actif le) et «Inactive on» (Inactif 
le), vous devrez également fournir une date. Pour plus d'informations sur les divers 
statuts du NRI, veuillez consulter le chapitre 13.3. 

Une fois tous les critères requis saisis/sélectionnés, cliquez sur le bouton «Search» 
(Recherche). 

À partir des résultats de la recherche affichés, la notification/le NRI spécial souhaité(e) peut 
être ouvert(e) en cliquant sur son NRI. 
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13.2 Rechercher un mélange/article 

Pour rechercher un mélange/article créé auparavant, sélectionnez «Manage mixtures» (Gérer 
les mélanges) ou «Manage articles» (Gérer les articles) dans la section «Chemicals, Mixtures & 
Articles» (Produits chimiques, mélanges et articles) du menu principal. 

Nom: indiquez le nom du mélange ou de l'article.  

Contient le produit chimique: recherche uniquement les mélanges/articles qui contiennent 
le produit chimique particulier. 

Les cases «Mixture» (Mélange) et «Article» peuvent limiter votre recherche aux mélanges ou 
aux articles (les deux sont recherchés si les deux cases sont cochées). 

Pour effectuer la recherche, cliquez sur le bouton «Search» (Rechercher). 

13.3 Statuts de NRI 

Actif Le statut d'un NRI devient actif lorsque: 

• la notification est entièrement traitée; 

• la date prévue d'une exportation est atteinte; 

• en outre, pour les produits chimiques listés dans les parties 2 ou 3 de 
l'annexe I, un consentement explicite positif valide est disponible.  

Un NRI actif indique aux douanes qu'une exportation donnée doit être autorisée.  

Inactif Un NRI est inactif lorsque: 

• la notification n'a pas encore été traitée entièrement; 

• la date prévue d'une exportation est dans le futur; 

• en outre, pour les produits chimiques listés dans les parties 2 ou 3 de 
l'annexe I, un consentement explicite positif et valide (ou une exemption) 
n'est pas disponible.  

 Une fois la notification entièrement traitée, le statut de la notification reste 
«Inactive» (Inactif) jusqu'à ce que la date prévue de l'exportation soit atteinte 
ou, dans le cas de produits chimiques de la partie 2 ou 3, jusqu'à ce qu'un 
consentement explicite positif soit reçu, selon la dernière de ces éventualités.  Si 
seul le texte «Inactive» (Inactif) est affiché, soit la notification n'a pas été 
entièrement traitée, soit aucun consentement explicite applicable n'est disponible 
dans le système. Si le statut est «Inactive» (Inactif) suivi d'une période de temps 
(p. ex. exportation autorisée: 01/01/2015 – 31/12/2015), la notification a été 
entièrement traitée ET un consentement explicite valide (si nécessaire) est 
disponible, mais la date prévue de l'exportation n'a pas encore été atteinte. Dans 
ce cas particulier, le NRI deviendra automatiquement actif le jour de la date 
prévue de l'exportation. 

Désactivé Un NRI désactivé signifie que soit un consentement explicite négatif du pays 
importateur est disponible dans le système pour la substance/le 
mélange/l'article, soit la soumission a été rejetée par l'AND/l'ECHA. 

Expiré Les notifications d'exportation sont valides pendant une année civile maximum. 
Une fois leur période de validité écoulée, leur statut devient «Expired» (Expiré). 
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13.4 Informations spécifiques sur les pays importateurs 

La section «Importing country info» (Informations relatives au pays importateur) (Figure 58) 
contient des informations spécifiques fournies par certains pays importateurs. La nature de ces 
informations est générique et elles sont par conséquent mises à disposition en dehors de la 
liste du consentement explicite. 

Figure 58: Informations relatives au pays importateur 

 

Les informations contenues dans cette section peuvent, par exemple, concerner: 

• des exigences spécifiques à remplir dans la notification d'exportation 

• des informations sur des produits chimiques interdits (ou des catégories de produits 
chimiques, p. ex. les pesticides). 

• des informations sur des produits chimiques pour lesquels le pays importateur a 
renoncé au droit de recevoir des notifications d'exportation 

• des législations spécifiques au pays 

Les informations sont accessibles à partir de la section «Importing country info» (Informations 
relatives au pays importateur) dans «Chemicals, Mixtures & Articles» (Produits chimiques, 
mélanges et articles), ou lors de la création d'une notification d'exportation. Dans ce dernier 
cas, si des informations sont disponibles pour le pays importateur en question, une icône rouge 
ronde contenant un «i» blanc s'affiche à côté de la liste déroulante (Figure 59).  

Figure 59: Icône indiquant à l'utilisateur que des informations spécifiques au pays 
sont disponibles 

 
 La section «Importing country info» (Informations relatives au pays importateur) 

contient uniquement des données sur un nombre sélectionné de pays. L'ECHA 
ajoute des informations à ePIC lorsque celles-ci sont mises à la disposition de 
l'Agence. 
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